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Guidelines for using your camcorder

Benefits of Video Analysis

Humans have quite slow vision... The human eye can only separate a maximum of
ten / twelve images per second. .. There are even some suggestions amongst
scientists that events lasting less than 0.25 seconds cannot usually be seen clearly.
Although coaches are irreplaceable in analysing athlete's techniques, often the
coach's eye cannot extract all the necessary details in a live sporting situation.,

Video cameras create the illusion of motion by ‘tricking’ the human eye. Video
cameras play 25 / 50 flashing still pictures each second. As an eye cannot separate
those pictures, we get the feeling of continuous movement. The use of a video
camera is a very effective tool to help you improve sporting technique. Quintic
video analysis software enables video capture at 25, 50, 100 or even 250fps. At
100fps each still image is 10ms, capable of capturing even the fastest of human
movement. In addition to just one video camera, Quintic has the capability of
capturing four live video images, simultaneously. The benefits of video have just

quadrupled 1?1

More and more athletes, coaches, scientists are using video feedback as a coaching
aid. Video can very quickly help athletes to understand the basic fundamentals of a
specific movement. Providing athletes with immediate performance feedback via
Quintic video software is a very powerful analysis tool... the images are used to
assist coaches in their task, as the athlete's performance can be repeated
afterwards and slowed down during critical phases.

By comparing performances of previous movements, or even other athletes, the
Quintic software enables you to compare video images via the computer screen.
Differences between the techniques can be identified (competition vs. training)
and this information made available immediately to the athlete. The coach and the
athlete can discuss what they see and plan a strategy for improvement, then repeat
the process. How the feedback is presented to the athlete when using Quintic is
highly dependable upon the skill of the coach or analyst.

They say 'Pictures paint a thousand words' and to see the critical
angles and positions qf your run up and delivery stride helps me make
instant changes to my action. Quintic is another dimensionfor any
training programme..."

Matthew Hoggard
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Over the recent years the role that information technology has played in sport
coaching has dramatically increased in a wide range of areas, including assisting in
the delivery of performance feedback. Practice should be a rewarding experience;
a video camera helps you make the most out of your time. When you watch
yourself perform via the computer screen, the image is there before your eyes,
instead of being just in your mind.

"Being able to synchronise different throws, current and best, proved

invaluable in preparationfor the games in Sydne)/ 2000 & Athens 2004.

I can compare the timing Qf current training throws with my best 90m
gﬁrorts from previous years. By syncbronising current and best throws at

release we could rewind in slow motion and ana])/se the dg'fferences. "

Steve Back]e)/

By studying your technique in depth, (frame by frame), you can start to building a
picture of what you're trying to achieve. Seeing an improvement can boost your
confidence. Normally it's difficult to correct a fault, even if you know what you
should be doing. This is because you don't see yourself in action. The slightest
alteration to the technique will always feel uncomfortable to begin with. Negative
thoughts and doubts can soon eat away at your performance. It is then you start
drifting into old habits, simply because that's what comes naturally. You have aged
bad habits and before long you are back to square one. When the video or
computer images are there in front of you, it's much easier to set yourself back on
the right lines. You can learn a great deal from studying your own technique on
video. The benefits of video apply to all levels of performance - from the beginner
to the Elite athlete, all you need is a video camera and Quintic software...
Remember the camera never lies. ..

" With the assistance of Quintic analysis software I've transformed my
putting stroke. Visually it looks quite different but the changes have been
quite easy to make. What you think you are doing, compared to what you

'

are actually doing can be two totally dg‘ferent things. !

David Howell
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More Detailed Video Instructions:

Whilst any camera is better than no camera and any video image is better than
none, some simple tips will enhance the value of your images... There are four
basic operations, which can significantly influence the use of cameras and the
quality of images. These are zoom, focus, shutter speed and iris.

During set-up of your camera, it is important to be at right angles, or 90 degrees
to the action. The zoom function in the camera changes the picture size and
allows you to stand much further back from the action. It is important that the
athlete is as large as possible in your camera view and the zoom allows you to have
all the details of the performance on the camera as you can restrict the view to be
just around the athlete. The camera should be set up so that the entire body is
contained within each frame. The correct distance between the camera and
subject should be recorded, to allow comparisons in the future (Typically 8-
10metres). Set the camera to automatic focus. Data collected using Quintic
Biomechanics must have a repeatable and consistent set-up protocol. This will
ensure the numeric & graphical representation of variables such as speed,
distance, acceleration are accurate. Quintic also accounts for any Parallax error
values during the calibration of any particular video.

However, if using a panning or moving camera often a manual focus will ensure
correct images are recorded. Auto focus constantly checks and focuses based on
what is at the centre of the picture. This, though, is not always practical when
videotaping athletes. By learning to use manual focus, you can avoid this problem.
Manual focus is set for a certain distance (you do not need to know the distance)
and anything that distance away from the camera is in focus. This is another
reason for you to stay far away from the athlete (and use the zoom function).

A good hint for manual focusing from a long distance is that you zoom in as close
as possible, focus your camera using something like the text on an athlete's
clothing and then zoom out to a desired level so that the whole athlete can be seen
in the picture. The image stays focused, as zoom and focus are independent of
each other.

The iris is the function in your camera, which allows the light come to the camera
through the lens. Many cameras have this only as an auto function and so you may
not be able to change it. In any case, auto iris is not such a bad thing as the lighting
conditions could change during the session, as happens when clouds go in the
front of the sun. If you have a camera with a manual iris option, then you can test
out its influence on the picture quality. Obviously, more light (smaller iris
number) makes your picture brighter (but can also make it too bright), while
closing the iris makes the picture darker.
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Shutter speed options are essential for good quality video taping of athletics
performance, particularly when the speeds are fast... In a normal situation, the
picture is taken over 0.04 seconds (25 pictures in a second). During even that
short time, however, an athlete can move a great deal and thus you see a blurred
image in your slow motion tape (like TV slow motion repetitions of a tennis ball
in a close line call - often you do not really see the ball at all, just a trace of
blurred ball images). Shutter speed allows you to reduce the time over which the
individual picture is taken. The majority of camcorders today have automatic
settings for various filming projects (refer to manufacture's guidelines). However,
the sports setting - typically a picture of a golfer or runner will provide you with
the highest shutter speed setting.

Note: That does not allow you to take any more pictures: there are still only 25 /
50 or 100 fps frames per second (as this is pre-determined by the camera and
computer software), but each picture is taken in a shorter period of time. A
shutter speed of 1/500s means that each picture is taken over a 0.002s. The down
side of increasing the shutter speed is that you need much more light. This is not
usually a problem outdoors, and it is recommended to use at least 1/1000s
shutter speed for athletics movement if possible, shutter speeds of 1/10,000 can
be used for particular sharp and clear images.. However, sometimes when filming
indoors you need to compromise and use a lower shutter speed. Additional

lighting may well be required.

Quintic would recommend you to make a verbal report to the camera after each
shot, throw, jump... for example; commenting on the flight, distance, result...
Without this information, the subsequent viewing of the tape will not give the
best possible information. Finally, remember that the videotapes always rewind
slightly at the end of the recording, so be careful not to cut away the end of the
performance when you stop the recording. Videotape a few seconds prior to and
after the actual performance. This also makes it much easier to look at the tapes,
as there are clear, distinct sequences on the tape.
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Trouble Shooting

Missing or dropped frames

When capturing video, a hidden file called sample.avi is generated. When you
trim in and trim out it is this file that is edited. When you next capture, this
sample.avi file gets overwritten with the new footage.

When first using the camera capture feature within Quintic you may find that
frames are dropped during the capture process. To overcome this, it worthwhile
defragmenting your hard drive.

When you use the same file over and over again, writing, rewriting, saving, and
deleting parts of it on the same disk, the file becomes fragmented. That means
that although you can't tell, your operating system is storing all the data from that
file as separate packages of information, distributed on different parts of the disk.
Although fragmentation does not lose the information contained in the file, it does
eventually slow down access to the file itself, because Windows must search the
whole disk to create the sum of the file's parts. Defragmentation collects all those
parts into one stream of data again, speeding up your system.

*. Disk Defragmenter

File  Action  Miew  Help

EX
Yolume Session Skakus File Svstem Capacity Free Space % Free Space
=AVAIO (T MTFS 27.94 GB 7.36 GE 26 %
=AVAIO (D) MTFS 27,94 B 5,37 GE 19 %

Estimated disk usage before defragmentation:

Estimated disk usage after defragmentation:

| Analyze | [ Defragment

B Fragmented files @ Contiguous files [ Unmovable fles [ Free space
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To defrag your hard drive for better capture performance do the following:
1) Capture 30 s worth of video using the camera capture software within Quintic
(do not worry if frames are dropped during this process).

2) Close down Quintic and all other applications.

3) Click Start, point to All Programs, point to Accessories, point to System
Tools, and then click Disk Defragmenter.

4) Select C: drive and click on defragment. Note: depending on the size of drive
and number of files this process can take a long time (allow for at least an hour).

5) Recapture.

After defragmenting, if you still experience dropped or missing frames then it is
likely that your computer is not powerful enough. Please email your computer
specification to Quintic for clarification.

Crosshairs

During calibration or digitisation, the cursor should be a crosshair as shown
below:

_|_

Crosshair cursor

However on some make of laptops e.g. DELL, this defaults to a text select icon as
shown below:

I

Text select cursor

If you have experienced this problem, could please contact Quintic
(info@quintic.com with your contact details, version of Quintic and the type and
model of laptop/computer. Many thanks.

Quintic are striving to correct this problem and recommend users in the
meantime to change the default cursor within the windows control panel.
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1. Go to control panel, mouse, pointers.

Mouse Properties

Tapping Function Mizcelaneous
Buttong Painters | Puointer Options Wheal Hardware
Scheme
|Windu:uws Drefault [gystem scheme) L | I

LCuztomize:

[z
|

“Working In Background %
Busy
_|_

Precizion Select

Handuwriting N
o
Enable pointer shadow

[ Q. H Caticel ]

2. Highlight text select, click on browse, and select cross_lI, click OK.

Browse
Lok, jm: | |- Cursars V| €] 2 B 0
i B 3dwnwse I beam_i I busy_rm & fillitup [ help_m
|t 23 = adwwe I beam 2 cain £uhand W help_r
My Recent *:1 appstar? I bearn_im R, counter '{2 handapst *@help_rl
Documents %y appstard | beam_l + cross L7 handnesw % help_rm
= Ry appstart 1 bearr_m + cross_j 7 handno "2} hibieamn
r % arrow | I bear_r 4= cross_il (* handns O hmove
Deskiop k arrow_il l bearn_l = cross_im % handrivwse 9 hine s
M arrow_im I beam_rm m B handwait 'E:.J hnodrop
. [ﬁ\g arrow_| T busy_i + cross_m Tahandwe @ hns
.——; Iz arrow_m E busy _il + cross_r ":) harrow Q hirmwse
13 i s
My Documents arrow_r E busy_im == cross_tl 'Q'}hcros.s hiarse
k arrow_tl E busy_| =+ cross_rm WY help_i T hourglaz
B k- arrow_rm E busy _m ﬁdinosauE h‘?help_il & hourgla3
Ej)g Q banana d busy_r @dinosaur M2 help_im T hourglas
: B barber g busy_rl & drum [%?help_l T by
by Computer
| *
e File name: |cross_| A | [ Open l
My Metwork | Files of fupe: | Curzors [* ani, *.cur] v | [ Cancel ]
Presig:
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Disabling a Web Camera

When using Quintic Capture, an inbuilt web cam can be recognised as a default
camera, to disable the web cam to allow capture from upto four video camcorders
please follow the instructions below.

Before following the instructions below please disconnect any other cameras that
are connected to your computer.

Right click on the My Computer icon found on the computers desktop or on the
start menu and select ‘Manage’

Open
Explore
Search...

Map Network Drive...
Disconnect Network Drive...

Create Shortcut
Delete
Rename

Properties

Computer

This will open the Computer Management window shown below
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File Action View Help

Computer Management =

$$|7_|;; L

;é‘ Computer Management (Local)
= Ué System Tools
@ Task Scheduler
2] Event Viewer
@] Shared Folders
* Local Users and Groups
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F="% Device Manager
B &5 Storage
= Disk Management
4 Services and Applications

HEEHE

K
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& Bluetooth

A Computer

g Disk drives

& Display adapters

S,g, DVD/CD-ROM drives

45 Human Interface Devices

g IDE ATA/ATAPI controllers

@ IEEE 1394Bus host controllers
=4 Imaging devices

<2 Keyboards

#]] Memory technology driver

B Mice and other pointing devices
= Modems

l‘-, Monitors

®¥ Network adapters

EB Portable Devices

Y3 Ports (COM & LPT)

B Processors

5 Security Devices

% Sound, video and game controllers
< Storage controllers

A System devices

& i Universal Serial Bus controllers

&
&
&
&

[

—

Click on the Imaging Devices option on the right hand menu, this will expand a
drop down menu identifying all of the Imaging devices currently enabled on your

computer .

File Action View Help

Computer Management i |

# (B Task Scheduler
2] Event Viewer
@] Shared Folders
[# # Local Users and Groups
@ Reliability and Performanc
% Device Manager
B &3 Storage
= Disk Management
4 Services and Applications

c]

&7 Emn
A Computer Management (Local) Bl g QUINTICPC
5 |} System Tools -\ Batteries

] L";-T) Biometric

- Bluetooth

[#-948& Computer

g Disk drives

&, Display adapters

24 DVD/CD-ROM drives

5 Human Interface Devices
@ IDE ATA/ATAPI controllers

@ IEEE 1394 Bus host controllers

[T - (- [ (- - 3

<2 Keyboards

1] Memory technology driver

) Mice and other pointing devices
1=/ Modems

A Monitors

&¥ Network adapters

B Portable Devices

13 Ports (COM &LPT)

3] D Processors

-[J® Security Devices

@& Sound, video and game controllers
-5 Storage controllers

[#-& System devices

(- § Universal Serial Bus controllers

[ - - - -

“a1 Sony Visual Communication Camera VGP-VCC6
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Right click on the web camera option and a menu will appear , to disable the

camera click on the disable option.

i;!Computer Management .
File Acton View Help

e w08 EIE RS
ES Computer Management (Local) El-g QUINTIC-PC

= {f} System Tools -\ Batteries
# (%) Task Scheduler -8 Biometric
& §3] Event Viewer - Bluetooth
[ ] Shared Folders [+-4& Computer
® 8 Local Users and Groups [#]— Disk drives
[ @ Reliabiity and Performanc | )&, Display adapters
= Device Manager [+ \TJ DVD/CD-ROM drives
El £ storage [#-4f Human Interface Devices
=¥ Disk Management [#-g IDE ATA/ATAPI controllers
B 4 Services and Applications - § IEEE 1394 Bus host controllers

=553 Imaging devices
T -

B Sony Visual Com

(-2 Keyboards Update Driver Software...
-] Memory technology d  Disable

- 1% Mice and other pointr  Uninstal

#51 (] Modems

o] changes

- Bl Monitors m
[#-&¥ Network adapters Properties

[+ Portable Devices

o

Y Ports (COM &LPT)
E Processors
149 Security Devices
[#-% Sound, video and game controllers
€5 Storage controllers
-1 System devices
- § Universal Serial Bus controllers

An confirmation message will now appear asking if you wish to disable the device,

click on Yes to continue the process.

! . Disabling this device will cause it to stop functioning.
—*— Do you really want to disable it?

Once this process has been completed you will be returned to the Device

Management Screen. The web cam will still be shown on the Imaging Devices

menu however now it a disabled icon is located next to it.

N.B. Disabling the device does not remove it from the computer if you wish to

use this device in the future it can be enabled again by using this process and
selecting ‘Enable’ rather than ‘Disable’
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Video Codec information

A video codec is a device or software that enables video compression and/or
decompression of digital video. They are used with Quintic Software to reduce
the size of the video file to benefit storage and transmission.

The many types of video codec have differing performance as there is a complex
balance between the video quality, the quantity of the data needed to represent it
(also known as the bit rate), the complexity of the encoding and decoding
algorithms, robustness to data losses and errors, ease of editing, random access,
the state of the art of compression algorithm design, end-to-end delay, and other
factors.

If a video file has been compressed with a particular codec then that codec has to
be available for decompression to enable its use.

COMMONLY USED STANDARDS AND CODECS

A variety of codecs can be implemented with relative ease on PCs and in
consumer electronics equipment. It is therefore possible for multiple codecs to be
available in the same product, avoiding the need to choose a single dominant
codec for compatibility reasons. In the end it seems unlikely that one codec will
replace them all. Some of the video codecs that Quintic currently uses are

MPEG-4 v2, DivX and Xvid,

MPEG-4 v2: An MPEG standard that can be used for internet, broadcast, and on
storage media. It offers improved quality relative to MPEG-2 and the first version
of H.263. Its major technical features beyond prior codec standards consisted of
object-oriented coding features and a variety of other such features not necessarily
intended for improvement of ordinary video coding compression capability. It
also included some enhancements of compression capability, both by embracing
capabilities developed in H.263 and by adding new ones such as quarter-pel
motion compensation. Like MPEG-2, it supports both progressive scan and
interlaced video.

DivX, Xvid, FFmpeg MPEG-4 and 3ivx are different implementations of
MPEG-4 Part 2.
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Missing codecs and video-file issues

A common problem when a user wants to watch a video stream encoded with a
specific codec is that, if the exact codec is not present and properly installed on
the user's machine, the video won't play (or won't play optimally). If a video
codec has not been installed when a video is loaded into Quintic’s main or best
screen an information box will pop up directing you to our website where a range
of codecs can be downloaded.

Quintic is unable ko play this video, Please check that wou
3 hawve the correct codec installed For this tvpe of video, 3
L Faor Further information please visit:- L

| i, quinkic, comdownloads) syskem_toaols, htm |

Help - My Video will not play in Quintic

If your video won’t load within the main Quintic software it is most likely due to

a codec error:

Please follow the instructions below to rectify this problem.

® Reinstall the Quintic codecs, navigate to C:\Drive\Program Files\ Quintic

® Open the Biomechanics, Coaching or Sports folder and open the codecs
folder, install the codecs one at a time by double clicking on the setup
icon.

® If you are using the Casio Exilim FH20 or F1 please go to
http://www .quintic.com/downloads/system_tools.htm and download
the required codecs.

If this does not solve the problem and your videos still fail to play follow the

instructions below:

i)  Download the GSpot video codec diagnostic program

from http://gspot.headbands.com/ ;
ii)  Open the program, select the video file and open it;
iii) The following information will then be shown:
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iv) Check the codec name and the installation status. What is the codec
name? [s it present and installed on your computer? Also take a screen
shot of this window (Ctrl+Alt+PrtSc and paste into a Word Doc and
save it) as Quintic may ask for this information if assistance is required.
Double check the codec installation by using windows media player, this
method produces a list of all the video and audio codecs installed on the
computer, to view this list follow the instructions below:-

Open Windows Media Player

Press the ALT key to access the menus dropdown.

Follow "Help"->"About Windows Media Player"

Click on the "Technical Support Information" link in the About Window
This will open a new window with a complete list of video applications
including all the installed video codecs. Can you see the codec named in
the GSpot program on the list? Take a screen shot of this page as Quintic
may ask for this information if assistance is required.

g1 A~ w N~

Try loading the video in Windows Media Player, does it run? If “yes” then try
installing the codecs located in C:Drive\Program Files\ Quintic.

If “no”, Windows Media Player will automatically try and find a suitable codec to
download; follow the onscreen instructions; once a recommended codec has been
located and installed, try running the video in Quintic again.
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If you are still having problems send the following information to
info(@quintic.com

® Copy of the video is possible

® Screenshot of the GSpot diagnostic program

® Screenshot of the Windows Media Player codec list

® Model and make of the camera that was used to take the video originally

® Model and make of the computer you are using and specifications

(processor, Ram etc)
¢ Windows Operating System

e User account, are you using an administrator account or a restricted access
user account with standard or specific restrictions?
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INSTALLING THE SOFTWARE — ADMINISTRATOR & NON-
ADMINISTRATOR ACCOUNTS

Quintic v21 has been designed so that the software can be used in both

administrator and user account modes.

Seven and Vista have two main types of user accounts: Administrator and
Standard. XP also has two main types of user accounts: Administrator and
Limited

Instructions and information

i) Installation
To install Quintic v21 an Administrator Account must be used, i.e.
only an Administrator Account can install the system effectively.

ii) Trial Mode
The software always loads in Trial Mode. This mode is accessed via the
“Register Later” option and allows the use of an effective but limited
version of the software for 21 days. It then stops working unless a valid
Quintic Licence has been registered.

iii) Quintic Licence Registration — Full Program
a) Fully registering a valid Quintic Licence via the “Register Online”
option will access the complete program. Again this must be done in an
Administrator Account.
b) Due to default restriction settings on Microsoft Operating Systems,
the full permanent program may require certain video codecs to be re-
installed to allow video playback. If an indicative message appears
during usage, please refer to the codec advice section within the
Troubleshooting chapter of the Quintic Tutorials for guidance. Quintic
Tutorials are freely downloadable from
http://www.quintic.com/tutorials_v21

iv) Access by any User Account
When the software (in Trial or Permanent mode) has been installed via
an Administrator Account, the software can be accessed and used by
double clicking on the Quintic shortcut icon on the desktop of any
User Account.
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V) De-Registering the Quintic Licence
Quintic v21 Licences may be De-Registered only by an Administrator
Account. Open the Quintic program and proceed via the Help Menu
tab. Select ‘Help’ and then select ‘De-register Quintic Licence’.
Follow the onscreen instructions or for more assistance please refer to
the De-register Section within the Quintic Tutorials.

Reasons for De-registering) the Quintic Licence

a) to make fundamental changes to the PC (e.g. re-formtting hard drive) which
otherwise could cause the Program to be locked out — the Quintic Licence can be
re-installed afterwards in the usual way.

b) to move the Licence to a different PC.

The automated system (in v) above) allows this twice in any 12 month period.
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To use the Quintic v21 Video Analysis Software you will need a personal
computer and a digital video camcorder of which there are many types... Mini
DV Camera, Scan Disk Camera (SD), Hard Disk Device Camera (HDD), High
Definition (HD), Casio High-Speed or Basler high-speed LIVE camera. Quintic
v21 has increased video format compatibility with the latest digital cameras
available on the market, producing video file types such as:

*.avi,*.mov,* .mpeg,*.wmv,* mp4,* flv,* vob,* swf, * mod, *.mpa ...

To capture digital video files, your personal computer will require a FireWire
IEEE 1394 / USB2 port along with a FireWire / USB2 Cable. The FireWire cable
transforms the digital signal from your digital camcorder into a format which can
be processed by your computer.

The FireWire / USB2 connects the DV-out port (Digital Video) from your digital
camcorder to the external port of your computer's FireWire port. Most
computers come with an inbuilt FireWire port and so all you will require is a
FireWire Cable. Sony VAIO Notebooks and Desktops, Dell, Toshiba and Sharp
Laptops are examples of computers that come with FireWire ports. If your
computer doesn't have a FireWire port, please see Quintic hardware for necessary
plug in FireWire cards.

Quintic software requires full administrator rights to load and run the
software for the first occassion. Once the software has been 'unlocked' using
Quintic security, then specific user accounts (if required) can be set-up on your
computer. This also applies to Network systems.

Note: A high specification graphics capability is recommended for the use of
Quintic Software - in particular Multi Camera LIVE Capture.

Quintic software is fully supported by Microsoft Windows Seven, Vista & XP

The Quintic Player System Requirements

e  Windows 95,98 NT,ME,2000,XP, Vista, Seven Operating System.
¢ Pentium II Processor with 128Mb RAM.
e CPU of 400 MHz or higher.

Windows Media Player v6.4 or higher. (Free download from Microsoft.com)
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Quintic Biomechanics v21, Quintic Coaching v21 & Quintic Sports v21
Minimum System Requirements

e Windows XP/Vista/Seven Operating System

e Pentium IV Processor/ Intel Core 2 Duo

e 2.2 GHz Processor with 2036 Mb RAM (50/60fps capture)

30 GB Free hard disk space (1GB for system Program - 9GB to store video
files)

o FireWire Port of Card for Quintic Single Capture

o Firewire Card for Quintic Multi or High Speed Capture. Note Firewire
Cards only necessary for laptops

o USB 2.0 / GigE ports for Quintic High-Speed Camera Capture

e Monitor resolution of 1024*768 pixels

e CD/DVD Read/Writer

+ Digital Camcorder DV Out

o Basler High Speed LIVE Camera

e Tripod

Quintic Camera Requirements

e« PAL / NTSC Mini DV Camcorders.

e Firewire port / IEEE — 1394 / i.Link

o Firewire cable for Quintic Single Capture — 4 to 4 pin or 4 to 6

e Firewire cable for Quintic Dual Capture — 4 to 6 pin

o Firewire cable for Quintic High Speed Capture — 6 to 6 pin.

o USB 2.0 port

e USB 2.0 cable for video capture (5m)

o Shutter Speed Settings — Sports setting

o Lens—0.8 Mega Pixel Lens.

 Tripod attachment for Live Capture.

 Basler Monochrome Camera — Quintic High Speed LIVE Capture.

« CASIO - High Speed camera : For more infomration please visit Quintic
Hardware / Casio

e Please Note: A medium to high specification graphics card is required for the
use of Quintic Multi Camera Capture

e DV IN port — for capturing footage from DVD or VHS.

¢ Manual Shutter Speed Settings 1/ 250" —1/20,000"

e Lens—0.8 + Mega Pixel Lens.

e C-Mount Lens for Quintic USB2 / GigE High Speed LIVE Capture
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About Quintic Consultancy

Q1: How long has Quintic been in business?

A: Quintic Consultancy Limited was started in 1997 by Dr Paul Hurrion PhD BA
(Hons) and Dr Robert Hurrion PhD MSc(Econ) BSc(Hons) and has grown
steadily and successfully into a major force in Biomechanical Analysis &
Consultancy and Performance Analysis Software across the world in Sport,
Education, Health and Fitness.

Q2: Where is Quintic?
A: Quintic head office is based in the centre of England close to Birmingham
International Airport and The Belfry Golf Club.

Q3: Who are Quintic’s customers?

A: Quintic provides Software to private individuals, schools, universities,
colleges, clubs, businesses, national and international sporting bodies and health
services across the world.

Q4: Apart from Performance Analysis Software what else does Quintic do?

A: Quintic undertakes Biomechanical Consultancy; has a top level personal Golf
Putting Analysis Laboratory; undertakes Biomechanical Lectures; and directly
assists National and International Review and Coaching Panels. See Consultancy

Pages for more information.

Q5: What does “Quintic” mean?
A: A Quintic Spline is a mathematical term for a line through points on a graph
frequently used in mathematical calculation of speeds and accelerations.

Choosing Quintic

Q6: Which is the right Quintic Software for me?

A: It is best to study the different features and consider how they apply to your
anticipated usage. The features of each product are shown in a helpful table near
the foot of the www.quintic.com/software page and it is a good idea to print a
copy for reference as you study the Quintic Products.

Q7: Why do you sometimes refer to Software and sometimes to the 'Quintic
Interactive Website'?

A: We refer to Quintic Sports, Quintic Coaching and Quintic Biomechanics as
“Software”. Quintic has a number of Interactive Websites that enable the user to
view coaching videos... for example: www.quinticsquash.com
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Q8: How do Quintic interactive websites differ from Quintic Software?

A: Quintic interactive websites are full and complete coaching manuals, with
hundreds of pages and videos of advice, that can be used both on a read only basis
and with video viewer can be accessed online - It is possible to purchase these
video for use on personal computers. Quintic Software systems are performance
analysis tools into which you capture video action for editing, viewing,
comparison and analysis - they are licensed to ONE computer only.

Q9: Why should I choose Quintic Performance Analysis Software?

A: Quintic Software has been designed specifically around the needs of our wide
range of clients to delivery Biomechanics analysis and, whether amateur or
professional, we believe the practical usage and benefit and the range and pricing
of our products cannot be beaten.

Q10: Why should I choose Quintic Interactive Websites?

A: Quintic Interactive Websites are interactive sports coaching programs, which
are viewed online for FREE or download for a cost onto a Personal Computer.
They contain coaching material specific to a given sport depending on the
website. Not only does the website contain typical coaching material found in any
text book, but it also contains computer video images and audio, which are
interactively viewed to give an extra coaching medium. Ideal for all levels of
coaches and athletes.

Q11: Are Quintic Products easy to use?

A: Quintic Products: are straightforward to use; are modular so each product
operates in a similar way; and contain all you need to know in comprehensive
online Tutorials. www.quintic.com/tutorials_v21.htm

Q12: How many computers can each Quintic Product be installed on?
A: Quintic Software is licensed to one personal computer only, multi-site
licences are available along with network licences.

Q13: Will Quintic Products perform on an Apple Macintosh computer?

A: Although designed to work with Microsoft Windows Seven, Vista and XP,
Quintic Products are supported by an AppleMac running Virtual PC or Bootcamp
with a suitable Windows Operating System. The correct video codecs will also be
required to play *.avi files on a AppleMac computer.

Q14: What are the special features of Quintic Products that will enhance my own
coaching practice and add benefit to my clients?

A: The Features Table [see Q:6] gives a guide to all of the features of the different
Products. They will assist you to a most comprehensive analysis and enable you to
demonstrate to clients more effectively and visibly. You can also provide a
performance CD for clients to take away or email them directly [see Q:16 & 17].
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Q15: What advantages do Quintic Products offer above a video editing tool?

A: You can create a database of performances; compare previous or best practice
with current performance; capture using one, two or high speed cameras, analyse
single or serial performances with drawing tools; use synchronised split screens
and blended images; calculate speeds, accelerations and angles; capture at 25, 50
or 100fps (frames per second) PAL European Standard or 30, 60 or 100fps NTSC
USA /Asia Standard; transfer digitised data into Excel ..... and much, much more
— see the features table www.quintic.com/software. Quintic can also be used as a
video editing tool, with filters, logo, text overlay along with the ability to crop
and compress the video file into a number of different formats.

Q16: What is The Quintic Player?

A: It is a FREE program for playing videos produced via the Quintic Software. It
is added as part of the 'Burn to CD' function to allow videos to be played at
normal speed, slow motion, frame advance, or loop, with zoom and full screen
options, and the active memo pad and audio memo feature to read any notes you
have saved with the original clip. The Quintic Player allows operation with
Windows 95 upwards and your own logo can be added to the opening window as
a reminder to clients. See www.quintic.com/software/player for more

information.

Q17: What is Quintic Audio Memo?

A: Audio Memo enables a user to record commentary onto any video file. This
commentary can then be played back using the Quintic Player or any other Media
Program. All you need is a microphone plug in on your computer.

Q18: Where Quintic Software is used in Podiatry and Physiotherapy, can it
synchronise with a force plate?

A: Yes — Quintic and RS Footscan have developed synchronisation software
enabling video captured through Quintic Biomechanics and images from the RS
Footscan Pressure / Force plate to be viewed contemporaneously via twin

windows. See www.quintic.com/software/biomechanics for more information.

Q19: What is digitisation?

A: Digitisation is available with Quintic Biomechanics & Quintic Coaching. It
converts movement into data to produce: graphical and numerical explanation;
transfer of data to Excel for analysis and demonstration; and allows calculation of
speeds, accelerations, and angles. This is most useful in Sports Science Studies,
Podiatry and Physiotherapy, and top level sporting achievement. See
www.quintic.com/software/biomechanics for more information. Quintic has the

capability of 2D automatic tracking of specific markers.
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Q20: What support does Quintic provide after I have purchased a Quintic
Product?

A: Your Online Tutorials provide permanent and easy to follow support.
www.quintic.com/ tutorials

A: Maintenance Contracts which include free upgrades, training & support are
available on an annual contract www.quintic.com/pricelist

A: Consultancy and Training are available by the day on site or at Quintic.
A: Quintic runs Training Clinics www.quintic.com/trainingdays

A: Upgraded software - also see Q:21.

A: Email support via info(@quintic.com

A: A commitment - Quintic want you to get the best from Quintic Products.

Q21: How often will the Software be updated / upgraded with new additions
formats etc.? Are these free?

A: Quintic continuously enhances its Products to meet customer requirements
and changing industry standards and developments.

A: All upgrades to Software are free to registered users within 3 months of
purchase. After 6 months, upgrades to Quintic Software are charged at 25% of
current retail price.

A: There is an option for clients purchasing Coaching & Biomechanics Software
to enter into a Annual Maintenance Contract at 15% of current retail price. This
includes free upgrades, training & support, for further details please visit
www.quintic.com/pricelist or contact us.

A: Quintic Lite was our entry level software package. This software has been
discontinued (June 2006). Please contact Quintic if you wish to upgrade your
version of Quintic Lite and get your money back against the latest Quintic

software.
Buying Quintic Products

Q22: What about the prices of Quintic Products?
A: For prices of Quintic Software Systems please contact info(@quintic.com

Q23: If I am buying on behalf of, say, a Medical Practice or College or Sports
Club, and need several licences, is there any special price?

A: Yes - Quintic Multi-site Licensing prices are both popular and advantageous.
Please contact info(@quintic.com for more details

Q24: What if I buy, say, Quintic Sports, use it for 6months, then decide I require
the extra functionality of Quintic Coaching?

A: Quintic allow you to upgrade your software at any time, we will refund your
original purchase price against the cost of the new product. This means that you
never lose your investment in your Quintic Software.
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Q25: How quickly does Quintic deliver?

A:Quintic Software can be purchased with a credit card and downloaded for
instant use. The software can also be sent via post, typically next day, and always
within 5 working days.

Q26: Does Quintic deliver worldwide?
A: Yes. For Quintic Sports, Coaching and Biomechanics post & packing is free.
Quintic Software is available for download via the internet for immediate use or

can be supplied on disk if required.
Correct Supporting Hardware & Media Components.

Q27: What are the computer system requirements to support Quintic Products
effectively?

A: Both minimum and recommended requirements are set out for each product
on our website at Www.quintic.com/ system_requirements.htm

Q28: Is there anything specific my desktop computer should have?

A: The free flow of data between camera and PC is vital. A desktop PC will have
[or can have installed] a direct FireWire Card [IEEE 1394 or i-Link] interface and
port or USB2. Many PCs have the interface as standard. See the Quintic hardware
packages and get advice and assistance at www.quintic.com/hardware. A medium
to high specification graphics card is required for the use of Quintic Software - in
particular Multi Camera Capture.

Desktop Firewire Card + 6pin to 4pin FireWire Cable

Q29: Is there anything specific my laptop computer should have?

A: The free flow of data between camera and PC is vital. A laptop that has a
direct FireWire [IEEE 1394 or i-Link] interface and / or USB2 port is best. Many
laptops have the direct IEEE 1394 or USB2 interface as standard. A Firewire /
USB2 Cable must always be used. See the Quintic Hardware Packages and get
advice and assistance at www.quintic.com/hardware. A medium to high
specification graphics card is required for the use of Quintic Software - in
particular Multi Camera Capture.
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Laptop Firewire + Camcorder + 4pin to 4pin Firewire Cable

Q30: Is the data flow rate /transfer rate /bit rate that important?

A: Yes — it requires a high rate to support capture at 50 fps particularly if the
moving target is large as with close-ups. Quintic do not guarantee good capture
performance at 50 fps if a direct FireWire [IEEE 1394] or USB2 cable is not used.

L

An external 'FireWire' Card that fits into the PCI MCIA Port on the laptop is
suitable for Capture with Quintic Software Systems.

Q31: Which is the best video camera for me to use with the software and
hardware for capture at 25/50fps (30/60 NTSC)?

A: Generally an expensive camera performs better than a cheap one but it is a
personal balance between required usage and price. The video camera /
camcorder must be digital with DV IN/OUT (IEEE 1394 / i-Link / Firewire
port),Or a USB 2.0 port, Sports setting AE, a minimum shutter speed of at least
1/1000th second and a quality lens. Visit the Quintic Hardware Packages and get
advice and assistance through www.quintic.com/hardware.

Q32: Which is the best High Speed camera for me to use with the software and
hardware for capture at 100 fps?

A: Quintic Video Capture Software is compatible with USB2 / GigE High-Speed
100fps Cameras. Visit the Quintic Hardware Packages and get advice and
assistance through www.quintic.com/hardware.

http://www .quintic.com/hardware/USB2_High-Speed_LIVE_Camera.htm
http://www .quintic.com/hardware/highspeed_camera.htm
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Q33: Will I need any Software Utilities to run Quintic Products and how do I
get them?

A: Yes — to run Quintic Products properly your PC must have Video CODECS;
DirectX; & Windows Media Player loaded and installed. If your PC does not have
them then the latest versions of each are available free from
www.microsoft.com/downloads/. [Microsoft XP includes DirectX and Windows
Media Player] If your PC does have them loaded then you should make sure they
are installed by locating and double clicking the relevant program file via My
Computer >C:Drive >My Programs. Please ensure that you also have AUDIO
codec present on your computer. DO NOT remove AUDIO Codecs from
your computer!!!

Please Note: A high specification graphics card is required for the use of Quintic
Software - in particular Four Camera Capture...

Q34: Did you just receive e-mail with a Zip file attached to it, or did you just
download a Zip file and don't know what to do with it?
A: This page explains the basics of Zip files and how to use them:

WWW. winzip .com

Using Quintic Performance Analysis Software

Q35: What sort of files does Quintic use?

A: Quintic v21 is compatible with most formats of video, including High
Definition. If you are using Quintic v17 software or an earlier licence (v14,
v9,v11) it is only compatible with AVI files. Other types of files must be
converted to AVI for use in Quintic Products via the Editor function within the
Quintic Capture software. See our Online Tutorials for further details
www.quintic.com/tutorials. The Quintic Video Editing Suite is available on all
three version of the software - Sports, Coaching & Biomechanics

"Trim' videos to reduce size or save specific content

e Save videos as compressed files - any codec can be used as long as it is
loaded on your computer.

o Unrivalled Video File Size - 15 seconds ~ 1MB (Quintic default codec)

e Open up any video file type to edit - Convert old incompatible video files
for analysis. ..

o Reduce the size of existing video libraries

« Improve the quality and size of existing video libraries
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Q36: I have a recently purchased a Microsoft Vista Operating System Computer,
however the Quintic sample videos on the website
www.quintic.com/software/sample_videos/ and the Q4E videos do not play on
my machine? What do I have to do in order to make them compatible with Vista?
A: Microsoft Vista uses a different video codec to that previously standard in
Windows XP Operating Systems and Quintic Software - the default codec for
Vista is XviD MPEG4 which is automatically incorporated in standard installation
of the Quintic / Vista programs. Due to this different codec, your own existing
Quintic videos, Quintic Sample Videos, and Quintic 4 Education videos will not
open unless you first obtain backwards compatibility. To obtain this compatibility
you must download the previous MPEG4 Codec to your Vista computer by
selecting the following link and following the seven step-by-step instructions.

o Please goto to the following page:
www.quintic.com/downloads/system_tools.htm

e LEFT CLICK on the Windows Vista Logo, save the file
'Mpg4Install.zip' onto your computer

o Unzip the file into a folder of your choice.

e Please read the 'READ ME.txt' file for detailed instructions.

« RIGHT CLICK on the "mpeg#4.inf" file (it should be in the same
directory as this Read Me note.)

e Choose the 'Install' option from the menu.

e Windows VISTA will ask for permission to continue. Press continue to
install the codecs.

o This will now enable videos with the MPGE4 Codec (such as those in
Quintic Sample Videos) to play in Vista Operating Systems.

Once you have downloaded the old MPEG4 and followed these steps, you will
then be able to use previously saved Quintic video files in Quintic on your Vista
computer. There is also the option to select the previous MPEG4 video Codec as
the default codec when in the Quintic Editor stage of your Quintic Program.
However, you may wish to choose the new XviD codec as your default video
codec. The increased quality of the new XviD Codec outweighs the small increase

in file size.

Please visit Product Table www.quintic.com/software/product_table.htm for
Vista compatibility and functionality.

Q37: What does “De-Register” mean?

A: Through Quintic Security each licence is dedicated to recognise one computer.
Any change in or of that computer means the software will not recognise it and
therefore not function. To allow for changes Quintic Security allows you to De-
Register the software twice in any 12 months and reinstall it on the changed

Appendix D



http://www.quintic.com/software/sample_videos/index.htm
http://www.quintic.com/education/index.htm
http://www.quintic.com/downloads/index.htm
http://www.quintic.com/software/product_table.htm

computer. NB — Change means a change of components within a computer or a

Change to a different computer.

Q38: If I change my computer, how do I De-Register the Quintic product to be
able to use it on the changed computer?

A: There is an automated system for which the computer must be connected to
the internet then - with Quintic software via the “Help” menu, select “De-
Register” and follow the simple instructions.

Q De-Register Your: Quintic Biomechanics w21 @

Quintic Software Security ® “gy"

Your Security Code A for this Quintic Software is:

You are permitted to operate this Quintic Software
on OME computer at any one time and have two
De-Registrations per annum. Proceeding with this
De-Registration will disable this Quintic Licence from
this computer. In order to use this Licence on
another computer you will need to submit the

Code D to the Quintic website. This will reset
Security Code A.

Do you wish to proceed with De-Registering 7

X Cancel De-Registering
Quintic Software Security ® Copyright 2003 All Rights Reserved

Quintic De-Registration Software Security Window
Note: by clicking Yes, you will De-Register your Quintic software and be issued
with a D Code - See Q39

Q39: I have just De-Registered my Quintic Sports from my old PC and received
my D code but my software was originally downloaded via the internet. How do
[install the Quintic program on my new PC?

A: In the same way as the original download - go to our website Members Forum
http://www .quintic.com/members_forum/ enter your details and use the
password you received originally, then follow the instructions. Please have a note
of your security code ‘A’ which you would have received upon purchase.
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Q40: Is it easy to learn how to use the software?

A: Yes. Quintic Software has complete Tutorials freely available online . You
should read through the Tutorials to gain an overview and familiarise yourself
with the various functions, and then work practically through the questions and
answers as you start to use the software. www.quintic.com/tutorials

Q41: Is it easy to change from using, Quintic Sports to Quintic Coaching?

A: Quintic Products are modular and so operation and layout of each product
version is very similar. The only difference between products is increased
functionality.

Q42: What if  have the wrong Font Size?

A: Certain icons with the Quintic Software are obscured with a DPI setting of
120DPI (Large Size). This will prevent you from seeing the icons clearly and in
some cases limit the functionality of the software. Some makes and models of
computers (Dell wide-screen computers for example) have a DPI setting as
120DPI as standard from the factory. You will need to make a change to this
setting by the following the instructions below:

Click on My Computer > Display Properties > Settings > Advanced > General
Display > DPI Setting > Normal size 96DPI

Q43: What Screen Setting should I use to have the correct window size on my
screen?

A: You should use the general setting of 1024X768 [make changes via >start
>My Computer > Control Panel / Settings > Appearances /Display >Change
Screen Resolution].

Note: Scrollable Windows allow for maximum screen usage. Maximum Screen
Resolution 1900x1200 for desktops & laptops or even wide-screen
configurations. You can also add an additional monitor to create a dual screen set-

up.

Q44: Will I have problems if my hard drive starts to fill up?

A: Possibly — you may not have space to store video; and the sample AVI file
footprint on the hard drive could be compromised. Defragmentation of the hard
drive should resolve this — select Start >All Programs >Accessories>System
Tools> Defragment — it can take a while and is worth doing overnight.

Q45: How do I put clients' files onto a CD for them to use with The Quintic
Player?

A: With Quintic Software Systems you are licensed to distribute The Quintic
Player free of charge. Within the Software is the 'Burn to CD' function that
enables you to send any analysed videos & The Quintic Player to the computer

Appendix D



http://www.quintic.com/tutorials/

CD drive. See our Online Tutorials for more information on this function
WWwWw.quintic.com/ tutorials

Q46: How do I email a clients' files for them to use with The Quintic Player?
A: With Quintic Software Systems you are licensed to distribute The Quintic
Player free of charge. Within the Software is the 'Instant Email' function that
enables you to email any analysed videos & The Quintic Player to your clients
inbox. See our Online Tutorials for more information on this function

www.quintic.com/ tutorials

Q47: When I use Export Analysis the colours in the exported video file have
become inverted. How do I correct this?

A: This problem has been discovered on Toshiba laptops and computers with a
graphics card of 16MB. Go to C drive > Program Files > Quintic > Right click
on Exportavi.exe. Select properties > Select compatibility > Display Settings
>Tick 'Run in 640x480 screen resolution'

Q48: Why can't I play a video in the Main and Best windows within the Coaching
CD’s?

A: Open Display Properties in Control Panel. [click Start, click Control Panel,
click Appearance and Themes, and then click Display]. Click the Settings tab,
click Advanced, and then click the Troubleshooting tab. Drag the Hardware
acceleration slider to the left. (if you place the slider in the middle this should be
sufficient to solve the problem). Click OK, and then click OK again. Restart the
computer when you are prompted to do so.

Q49: Why do I get an Error message “De-interlacing filter not installed” is shown
when you try to play a video within Quintic?

A: This indicates an error during installation and set-up, for example the AVI
Synth file has not run. Run your PC with no applications open. Go to Start > My
Computer > Main Hard Drive :C (or other main drive) > Program Files >
Quintic > AviSynth. Open AviSynth and click through the set up process - it's
very quick. Then Restart the PC.

Q50: What does it mean if I get the Error message "Incorrect video format ".

A: The "Incorrect video format " message usually indicates that the Video Codecs
utility is not running. The Codecs file is provided on the Quintic CD and will
have loaded but it is not running. To run it, go to the actual file via Start >My
Computer > CDrive > Program Files > Quintic > Codecs and click to run it -
choose the Reinstall All Components option when you get there.

If there is still a problem then it may be that the "user account" where the
programme is installed in does not have full Administrator Rights. The software
does need full Administrator Rights to access the necessary utilities etc. If that is
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the case then Remove and reinstall in a User Account with full Administrator

Rights )

Q51: Why when the Quintic windows are resized are certain buttons hiding?

A: To solve this close all currently running programs. Right click on the desktop
and select 'Properties’. Click on the 'Appearance’ tab > Select the first drop
down menu under the heading 'Windows and buttons’ Select "'Windows
Classic style'. Press the Apply button. You may also have to restart your
computer.

Using Quintic Capture Software

Q52: s there any need to use any other Capture or Editing software?
A: No — Quintic Products incorporate all necessary editing and capture
software.

Q53: What are the basic fundamental practices of video capture I need to be
aware of to ensure my practices are consistent with this coaching tool?

A: Please have a look at the Benefits of Video section on our website at
www.quintic.com/benefits_of_video.htm

Q54: Will I have to capture my own video straightaway to practise with the
software?

A: No — Quintic provide short clips of sporting action online at the following
page: www.quintic.com/software/sample_videos and also provide a Sample
Video Library on disk with your software.

Q55: What is a FireWire / 1394 / IEEE 1394 / i-Link?

A: All these terms refer to the IEEE 1394 standard defining a high-speed mode of
transmission that guarantees bandwidth for connections between computers and
digital video cameras. The FireWire Card in the computer and the FireWire cable
are the two necessary components.

e

4-pin to 4-pin (Laptop - Camcorder) / 6-pin to 4-pin (Dual Capture)
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Q56: Why are there 3 different types of FireWire Cable, and which one should I
buy?

A: FireWire cables vary depending on whether or not your camera requires
power from the computer to operate it.

A: Quintic Single Capture requires a digital Camcorder & 4-pin to 4-pin FireWire
Cable.

A: Quintic Dual Capture requires 2 digital Camcorders & 4-pin to 6-pin Firewire
Cables.

A: Quintic High Speed Capture requires a USB2 or GigE Cable.

Q57: Is there much practical difference between the capture speeds of 25 fps
(frames per second) PAL European Standard (= 30fps NTSC USA /Asia
Standard) 50 fps (= 60 fps NTSC) and 100 fps?

A: Yes, the higher the frame rate the more information there is to analyse. This is
very important for seeing and analysing technique in fast moving sports — for
example a golf swing or a cricket bat. Only Quintic Coaching and Quintic
Biomechanics have the option to produce videos at 50(60) upto 250fps....

Q58: What size AVI file does Quintic capture for analysis?

A: Quintic Captures in a AVI format although any format of video can be opend
in the main software for analysis. A typical Quintic AVIfile of 15 seconds in
duration at 25fps is IMb, 5 seconds in duration at 50fps is IMb & 3 seconds in
duration at 100fps is IMb. These are ideal for analysis or distribution via The
Quintic Player or internet /email. The standard Microsoft AVI size maximum of
2Gb must not be exceeded or the sample AVI footprint on the Hard Drive will be
invalidated.

Q59: Are there common problems when capturing and analysing video?

: Not carefully following the Tutorials / Instructions.

: Media Components not loaded or loaded but not installed.

: Wrong capture settings — see Tutorials. www.quintic.com/tutorials
: Not using a firewire card / firewire cable.

: Insufficient capacity in the PC.

: Not having the camera steady on a tripod — see Tutorials.

Pl

: Poor battery power on laptops — mains power will optimise laptop

performance.

Q60: Why is it dropping frames during the capture process?

A: Your computer may not be powerful enough or close to capacity. Ensure that

you have followed the Set Up option within the Video Capture Software. Help on
how to do this can be seen at www.quintic.com/tutorials within the Appendices.
A: Defrag the computer by right clicking on the D or C drive and selecting
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‘Properties’ Select the ‘Tools’ and then select the defrag option. Allow the
computer to defrag both drives and then restart your computer.

Q61: Can I use existing footage from video tapes?
A: Yes — with your DV In/Out Camcorder using a SCART lead with an in/out
switch via the TV / VCR. See www.quintic.com/benefits_of_video.htm for

more information

Q62: We have been having problems obtaining accurate angle results using the
Quintic software program. We have been measuring a static angle and comparing
it with a known angle (using a goniometer), but the angles we are obtaining using
Quintic have been different compared with the known angle.

A: This problem relates to the aspect ratio of the cameras you are using. If the
camera records in 16:9 or 4:3 ratio then the vertical and horizontal ratios are
different, to obtain accurate results the video has to be calibrated (both vertically
and horizontally).

Once the video has been calibrated, Quintic Manual or Automatic digitisation can
be used to calculate the angles. If the angles tab is used to calculate the angle
values, they may be 2-3 degrees out as the angles function does not take into
account the video calibration file. If a camera that records at 1:1 ratio is used then
the video does not need to be calibrated as both vertical and horizontal ratios will
be correct.

Q63: Can analysis done in earlier versions of Quintic be used in Quintic v21?
A: Yes analysis files that have been saved in earlier software versions (v17) are
compatible with v21

Q64: How many cameras can I capture from?

A: Quintic Coaching Multi Capture allows the user to capture from up to 2 live
cameras (50/60fps), and Quintic Biomechanics Multi Capture allows video
capture from up to 4 live cameras (50/60fps).

A: Quintic Sports & Coaching allows the user to capture from one high-speed
USB2 / GigE camera.

A: Quintic Biomechanics Multi High-speed Capture allows video capture from up
to 4 live cameras (250fps) GigE only...

Q65: As more accurate smoothing and filter values are used in v21 should I re-
filter/re-smooth my data?

A:lt is not necessary to re-smooth your data as there have only been small changes
to the filter and smoothing settings for v21, unless you are comparing data
collected in v9 / v14 with v21.
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Q66: Is Quintic Compatible with High Definition Video?
A: Quintic v21 software allows the playback of HD video, however HD video
capture is currently not supported.

Q67: When I load up premier capture and start using the single camera function I
see the following error message ‘INVALID FLOATING POINT ERROR’

A: This error message occurs in v14 due to changes in the Vista OS by Microsoft
which now prevent direct capture of video onto your hard drive.

We have produced a patch to resolve this. Please go to our Website >
Downloads > System Tools to download the patch - it's not difficult as you are
merely substituting one file for another but please do carefully follow each line of
the instructions.

Q68: I am using a Casio Exilim F1 camera with Biomechanics v14 but I
can’t open the saved .MOY files in the software.

A: This error is occurring because the codec required to run .MOV files is not a
standard codec within your Windows OS.

To resolve this problem before the release of v21 please go to
http://www.quintic.com/downloads/system_tools.htm and download the latest
Vista video Codec package. With this package installed you will be able to:
use the Quintic Player to play video clips such as Quicktime, RealMedia, avi,
mpeg, Flv, swf, wmv, etc. Installing this codec will also allow you to use the
Quintic Software Video Editor (Play any clip — see Quintic Tutorial 5B) to
render the files for analysis within the software.

A: Quintic v21 allows the user to play most video formats including . MOV files.

Q69: I have just captured a video and now when I open it in Quintic the following
error message appears:

DirectShowSource: could not open as video or audio.

Video returned: "DirectShowSource: unable to determine the
duration of the video"

Audio returned: same as above

C:\QuinticWORKING\Input.avs, linel)

A: This error message indicates that the Avisynth component has been corrupted.
To rectify this problem please follow these instructions:
® Delete the AVI Synth program from Program Files, using the
Add/Remove programs option located in Control Panel).
® Empty Recycle Bin
® Navigate to the Quintic Program files (c: \Drive\Program Files\ Quintic \
Quintic (Sports Coaching or Biomechanics)\ AviSynth and run the AVI
Synth exe. Now reboot your machine.
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Q70: When I save a video using Quintic Premier Capture I get the following
Error message:

It is not possible to write to the video C:\*.avi

This video may be in use in either the Main or Best window of your
system. Please check...

A: This error message occurs due to an invalid video codec being used. Microsoft
have omitted previously standard drivers from Windows Vista, and certain
Codecs such as the Microsoft MPEG-4 Video Codec V3 cannot be used to save
videos. Quintic currently recommends that the Xvid Video Codec package is
used with Quintic Video Analysis software being run on a Vista OS.

Therefore to capture and save your videos successfully please select the Xvid
MPEG-4 Codec from the drop down menu (see below) and then click on the save
video button to save your captured video.

O Qo Pramie Copte o e

Q=

Preview | Single | Series | instant  Editor | Fiters |

(& payaydn] ([@lestaotes [ lestcompresson|

Compression Options

¥)\ideo Campresson On  TRRTRIIENIIR s v
ALdho O Maosoft MPEG-4 Video Codec V3
Microsoft MPEG -4 Video Codec ¥1 l
/| De-Interface Video
3 Compressor
Wideo Size Cinepak Code by Radus
@ Ful Sge Panasanic DV CODEC

Half Size

[ save video |

Reset Preview | 01 | Reset video Filters | =

Copyright © 1997-200% Quintic Coneultancy Lid. Al Rights Reserved

If this Codec option is not available on the drop down menu please use the link to
our system tools page:

http://www.quintic.com/downloads/system_tools.htm and download the Xvid
Codec Utility.

Once downloaded onto your computer please double click on the setup icon and
follow the onscreen instructions, please make sure that during the installation
process the decoding option is selected (see below)
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&8 Setup - Xvid =] = |

Select Additional Tasks
Which additional tasks should be pefomed?

Select the additional tasks you would like Setup to perform while installing Xvid, then
click Next.

Decoding Options:
7] Decode ail supported FourCCe {Divié, DXA0, MP4VE

| < Back ” Next > | | Cancel |

Once the installation has completed you should be able to select the Xvid Codec
option from the drop down menu within the premier capture window.

Q71: When I open a video in Quintic I am seeing this error message: NO
DRIVER INSTALLED / MISSING DRIVER / CANNOT FIND DRIVER

A: "No Driver Installed" generally means that the one or more utility programs
are not loaded or are loaded but not running. Sometimes security / settings can
prevent this automatically happening when you load. Also Vista will not support
XP produced videos as Microsoft have omitted previously standard drivers and so
without the fix below you will not play XP produced clips on Vista..

Please go through the routines below to resolve the problem (only takes a minute
OT SO).

QUINTIC CAPTURE

Quintic works with mini-DV camcorders via firewire.

Have you captured these videos through Quintic or some other software?

They may be AVI files but that is like saying "Ford" - many different types.

If they are not captured through Quintic then you can use the Quintic Editor
feature (Play any clip) which will render most AVI files to be saved in the correct
format. See Quintic Tutorials 5B - video editing.

USING VISTA?

Because Microsoft have omitted previously standard drivers from Windows Vista,
it will not run video clips captured with Windows XP. If this is happening you
might have missed our message about drivers when you loaded the Quintic
Program. Go to our www.quintic.com Downloads menu and select System Tools
and download the missing Codec. It is in a Zip File and you will need to extract it
onto say your desktop and run it from there. Vista will then play "XP Videos"
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CODECS

1. Run your PC with no applications open.

2. Go to Start > My Computer > Main Hard Drive C: (or other main drive)
> Program Files > Quintic > Quintic Sports/Coaching/Biomechanics > Codecs.
3. Open Codecs and click through the set up process - it's very quick.

4, Choose the Reinstall All option at that point.

5. Then Reboot the PC.

AVI Synth
1. Run your PC with no applications open.
2. Go to Start > My Computer > Main Hard Drive C: (or other main drive)

> Program Files > Quintic > Sports > AviSynth.
3. Open AviSynth and click through the set up process - it's very quick.
4, Then Reboot the PC.

Q72: My angles and shapes aren’t appearing when on the exported
images when i create a multiscreen capture

A: This is because of the smaller screen ratio, increasing the line thickness of
either the shapes or angles will solve this problem.

Q73: My video won’t play in the Quintic software I keep seeing this
error message:

Warning

Quintic is unable ko play this video. Please check that you
'E hawve the carrect codec installed Far this type of video. 1
L] For further information please visit:- L]

| wiw, guintic. com/daownloads)system_taals.htrm |

A: This error message is appearing due to the necessary video codecs not being
available to play the video, for more details please see the trouble shooting section

Q74: Can Quintic be used on a user account without administrator
rights

A: Yes Quintic can be used on a user account, however an administrator account
must be used to install the software. N.B video codecs may also have to be
reinstalled via the user account to allow video playback.

Q75: I am running Quintic v21 in a user account, when I try and play a .Mov file
it doesn’t play.

A: When using Quintic software in Windows Vista and XP User/Limited
accounts, it may be necessary to use an additional video codec to play *.mov files.
For example *.mov files captured via a Casio High-Speed F1 camera. Please run
your computer in User mode before buying the codec below to discover if you
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require the additional codec. Some Sony Vaio Vista PCs have installed this codec
as their own default. Each codec costs £9.99 per computer.

. http: / /www.roxio.co.uk/ eng/ products/ cineplayer/ vista/features.html -
Windows Vista
e http://www.roxio.co.uk/ eng/ products/ cineplayer/decoder/overview.h

tml - Windows XP
e Click on 'Buy Download' and follow the instructions given.

Q76: When using the tape, sometimes (depending on the make and model of the
camcorder) the tape doesn't automatically play after completing a video capture?
A: There are many types of camcorder, if this should happen, please manual start
the tape using either the remote control or play function on the camcorder.

Q77: How can I enquire or ask more questions?

A: We shall be pleased to respond to your enquiries and questions through our
Contact page : www.quintic.com/contact_us/. If you have a technical question
then please tell us: Which Quintic program and version you are using; Which
operating system you have ; make and model of camera you are using and how it
is connected to your computer ; and at what particular point the problem you are

g

encountering.
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Glossary of Technical Terms associated with

Quintic Products

Active window: The window that you are currently using or that is currently
selected. Only one window can be Active at a time, unless the synchronisation
function is being used. The Active window has a dark blue border along the top of
the screen. The current file name and directory is displayed in the title bar at the
top of the window.

AVI: Audio Video Interleave : the format of the video files needed to run within
the Quintic software.

Compression: Video files can be large. Compression reduces their size with

negligible loss of quality.

Directory or Folder: Part of a structure for organizing your files on a disk.
Directories/Folders are an extremely useful tool, allowing you to group related
files together in the same directory/folder for easy access. When you select a
particular directory/folder, the files it contains are instantly displayed.

Double click: To twice press and release quickly the left (usually) mouse
button.

Drag mouse: Press and hold down the left mouse button while moving the
mouse - for drawing lines and angles within Quintic Products.

Draw: To mark on a frame of a video file using options under the Draw Menu -
Line drawing / freehand drawing.

Drop down Menu: A menu that opens from a command on another menu. A
command that opens a cascading menu has a right arrow next to it: for example
Digitisation : Set step size 1, 5 or 10.

FireWire / 1394 / IEEE 1394 / i-Link: All these terms refer to the IEEE 1394
standard defining a high speed mode of transmission which guarantees bandwidth
for connections such as between computers and digital video cameras. A FireWire
and firewire cable must be used with Quintic Products

Filename: The name given to a file of information on disk.
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Frame: One still picture from a video file. Individual frames or a sequence of 6 or
12 frames may be captured within the program and printed out within a word
document. This function is ideal for reports.

Hard Disk / Drive Capacity: This is the amount of storage space on your
computer

Inactive window: A window that is not currently being used. The next
movement by the mouse action or keyboard will not affect its contents. An
inactive window can be activated by clicking on it.

Markers: 10 markers are available to the user. This enables 10 frame numbers to
be chosen by clicking on the marker icon. The video clip that contains a frame
number chosen by selecting markers can be saved. Any previously saved markers
will default on when opening the relevant video clip. By marking a video frame,
you can easily return to that frame by clicking on the marker tag. It is possible to
reset all 10 markers, or each marker can be reset individually by placing the
cursor over the marker tag and pressing the CTRL key.

Play: To initiate the play of a video file, either through its entire sequence of
frames or frames specified using Main file menu. There is a shortcut key to play a
video clip on the toolbar.

Scroll Bar: To move through a video clip frame by frame using the scroll bar.

Screen Resolution: Settings of the monitor, the Quintic system best runs on a
screen setting of 1024 x 768 pixels.

Title Bar: The blue horizontal bar at the top of the monitor screen that contains
the number of the open window, the title of the system and the name of the
current file.

Toolbar: A menu of quick selections (icons) across the top of the monitor screen
and below the menu bar. The items in the toolbar are the most commonly used
features in the Quintic System and are available by clicking the mouse on the
desired icon.

Trace: Marking the position of a point or object frame by frame through a video
file - creating a point trajectory.

Video file: A video clip that has been given a name and is stored on the disk.
This file can be accessed by selecting Open Video under the File Menu. Quintic
Products use only * avi files.
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Window: A framed area on the computer screen within which you may place a
file for manipulation. Quintic allows you to open one or two windows, but only
one window may be active at a time unless you are using the synchronisation
mode.

Glossary of Biomechanical Terms
KINEMATICS

MASS

The quantity of matter in an object. The mass of an object will, remain constant
regardless of location or gravitational conditions (e.g., earth or moon gravity).
The importance of mass in mechanics is that it represents, in linear terms, the
resistance to a change of state (a speeding up or slowing down). The unit of mass

is the kilogram (kg).

CENTRE OF MASS
The point at which the mass of the body acts (the point representing the mean

position of the matter in a body).

KINEMATICS

Description of motion of a body.

LINEAR MOTION
Motion in which all parts of the body travel along parallel paths.

ANGULAR MOTION
Motion in which a body travels along a circular path; all parts of the body travel

though the same angle, in the same direction, at the same time.

SCALAR
A quantity that only has magnitude, for example, mass, and length, are both scalar

quantities .

VECTOR

A quantity that has both direction and magnitude. A force, for example, is always
described by its size and by the direction in which it is acting. Velocity is also a
vector quantity because it expresses the rate of change of position in a given

direction.

DISPLACEMENT
The Change in the position of a body.

VELOCITY
The rate of Change of displacement.
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ANGULAR VELOCITY

The rate of movement in rotation.

ACCELERATION

The rate of change of velocity with respect to time.

ANGULAR ACCELRATION

Angular acceleration refers to the rate at which the angular Velocity ofa body

changes with respect to time.

FORCES

FORCE

A vector quantity that describes the action of one body on another.

MOMENT ARM

The perpendicular distance from the point of application of a force to the axis of

rotation.

LEVER

A lever is a system that tends to change the mechanical advantage of an applied
force. Basically, it consists of two forces and a fulcrum or hinge. The two forces
are called an effort force (such as a muscular force) and a resisting force (such as a
weight held in the hand or a ground reaction force). The perpendicular distance of
each force from the fulcrum is called the lever arm.

fulcrum

muscles at back
af haad

fulerum

b) Second Class Lever

On the same side of the fulcrum with
resistance arm closer to the fulcrum.

a) First Class Lever

On opposite sides of the fulcrum.

®) calf muscle

cffort

Achilles tendgn

fulcrum

laad
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c) Third Class Lever

fcl " On the same side of the fulcrum with
' affart the effort force closer to the fulcrum.

fularum @_';ﬁ load

steam

& - — ‘In:lau
¥

fulerum affort ioad

GROUND REACTION FORCE
The forces that act on the body as a result of interaction with the ground.

"
GROUND REACTION
- FORCES
% Rz
Fe 3
FORCES APPLIED TO
THE GROUND
R
GRAVITATIONAL FORCE

The force exerted on an object as a result of gravitational pull.

g

The symbol used to represent the acceleration because of gravity on earth.
Although this quantity actually varies according to location and altitude, the usual
value used is 9.81 m/sec’
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KINETICS

NEWTONS LAWS

1. Newton’s first law states that a body will maintain a state of rest or

uniform motion unless acted on by a net force.

2. Newton’s second law states that the change in momentum of the body
under the action of a resultant force will be proportional to the product of
the magnitude of the force and the time for which it acts (i.e., the
impulse). The second law also states that the change in momentum will be
in the direction of the resultant force.

3. Newton’s third law states that action and reaction are equal and opposite.

LINEAR MOMENTUM

The product of the mass of an object and its linear Velocity.

ANGULAR MOMENTUM

The rotational equivalent of linear momentum that can be thought of as describing

the "amount of motion" that the body possesses during rotation.

WORK

Work (W) is done when a force moves an object through a distance. Whenever a
constant force exists and motion takes place in a straight line, then work equals
the magnitude of the force (F) times the distance (d) through which the object

moves

(W =Fd).

POWER
The rate of doing work. Power (P) is equal to the work done divided by the time
during which the work is being done: P = W/t.

ENERGY
The capacity for doing work. In any system, this capacity cannot be destroyed,
but energy can be transformed from one form to another.

KINETIC ENERGY

That component of the mechanical energy of a body resulting from its motion.

POTENTIAL ENERGY

That component of the mechanical energy ofa body resulting from its position.
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MUSCLE MECHANICS

CONTRACTION

Development of tension by a muscle whether or not shortening is underway.

MUSCLE ACTION

The development of muscle tension (more appropriate than the term

"contraction"). It can be applied to any type of tension development regardless of
whether a muscle is lengthening, shortening, or maintaining the same length.

ECCENTRIC MUSCLE ACTION

Muscle lengthening under tension. This lengthening occurs when the external

force acting on the segment to which a muscle is attached causes a net moment
that is greater than the moment that is being developed by the muscle and its
synergists.

CONCENTRIC MUSCLE CONTRACTION

Muscle shortening under tension. This shortening occurs when the net moment

developed by a muscle and its synergists is greater than the moment caused by the
external forces acting on the segment to which the muscle is attached.

ISOMETRIC CONTRACTION

Muscle action that involves no change in length of the muscle the action of a

muscle when no Change exists in the distance between its points of attachment—
referring to the joint and not to the muscle.

ISOTONIC CONTRACTION

Muscle action that involves the production of a constant force.

ISOKINETIC CONTRACTION

Muscle action in which the rate of shortening or lengthening of the muscle is

constant.

ORIGIN
The source or beginning of a muscle. The term generally refers to the more fixed

end or the more proximal end.

INSERTION

The more distal attachment of the muscle or the attachment that is more mobile.
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TENSION- LENGTH RELATIONSHIP

The variation in force output of a muscle, with the same neural input, over a
range of lengths. The reasons for this variation include a change in the number of
possible active sites for cross-bridge formation and the effect of the elastic tissues
that are in parallel with the contractile tissue.

TENSION

LENGTH

FORCE — VELOCITY RELATIONSHIP
At any given length, the speed of shortening or lengthening of a muscle that is

stimulated at a constant level will depend on the force that is applied to the ends
of the muscle. The Hill equation, best known of the force-velocity equations,
describes mathematically the fact that light loads can be lifted quickly but heavy
loads only slowly. Although it is often stated that maximal muscle force is
available at zero velocity (isometric action), the highest loads are achieved during

eccentric muscle action.

T 1 4
Eccentric Concentric
Force
Isometric

Maximum . . Maximum

) D — Velocity > .
lengthenlng shortenlng
velocity velocity
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Quintic Sports Science

What is Biomechanics?

The word 'biomechanics' is derived from the Greek bios meaning
life and mekhaniki meaning mechanics, so that biomechanics may
said to be the study of the mechanics of life forms. The extent of
this subject area is evident in research of plants, insects, reptiles,
dinosaurs, birds, fish, whales, elephants, kangaroos and humans. In
the biomechanics of humans, topics range from the mechanics of
bone, tooth, muscle, tendon, ligament, cartilage, skin, prostheses,
blood flow, air flow, eye movement, joint movement to whole
body movement. In human movement biomechanics, topics include
injury, clinical assessment, rehabilitation, ergonomics and sport.

Sports biomechanics uses the scientific methods of mechanics to
study the effects of various forces on the sports performer. It is
concerned, in particular, with the forces that act on the human

neuromusculoskeletal system, velocities, accelerations, torque,
momentum, and inertia. It also considers aspects of the behaviour
of sports implements, footwear and surfaces where these affect
athletic performance or injury prevention. Sports biomechanics can
be divided up into two sections:

Performance Improvement & Injury Prevention

With the help of Quintic, we aim to provide answers to performance related
topics:

What is the best run-up for a high jumper?

How should they knee angle be modified for the delivery stride of a fast bowler in
cricket?

What is the Velocity of the swimmer after the tumble turn?

These questions are of the form: What is done? How is it done? Why does it
work? The answers to What? How? and Why? are important to the athlete, coach
and scientist, respectively...

"Biomechanics is the science concerned with the
internal and externalforces acting on a human body

and the ejfects of these forces... "
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Example of Quintic Biomechanics in Rowing:

From video footage of rowing tank training, the Quintic software enabled
techniques of different rowers to be analysed and compared. Further to that, the
Quintic Biomechanics enabled the velocity of the oar handle to be monitored and
compared for the different rowers.

mﬁ el Doz umeen o wart i WAV 25 A oweng S acah VGl 2 - adal _J_m!l
Main | Markers | Shapes | Angles | CapheeSivle  Dighisation | System | Help |

NS B e B

The figure above shows a Quintic trace of the oar handle through two strokes.
The analysis program calculates velocities and accelerations along this line, which
can be directly analysed. The velocity and acceleration data displayed in the
analysis program can be exported into a spreadsheet. This allows a more detailed
and specific analysis to be conducted.

The figure below shows an example of this. Two velocity traces of two different
rowers, working at different stroke rates are compared below. The velocity traces
are shifted in time so that the beginning and end of each stroke coincides. This
enabled the direct comparison of velocity and acceleration. The velocity graphs
below, generated from the Quintic Analysis program, show the higher speeds
generated by Sarah in the driving phase of the stroke, and the significant
difference in the velocities in the return phase.
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Sarah - Inside Stroke Side Ruth - Inside Stroke Side
Start 0 Start 12
Finish 124 Finish 134
Frame 5 Frame -4
0 0 0 -0.0328
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How can a Sport Psychologist help you?

There are many myths about Sport psychology.

What does a Sport Psychologist actually do? The

reality is that applied Sport Psychology is based
on very simplistic principles. One principle
endorsed by many practitioners is the KISS
approach (Keep It Simple Stupid I!).

Such an approach is important as many
individuals experience problems with their
mental game simply because they ‘over
complicate’ things. Part of the Sport
Psychologist's job is to simplify an individual's
approach to the mental game, so that they feel
‘in control’ of their performance.

Much of what we do in Sport Psychology is
taken from the experiences of those individuals
who have made it to the top of sport. There are
many mental skills, which can be enhanced
through mental training; these include. ..

Controlling anxiety (nerves)

* Visualisation,

* Developing concentration,

* Confidence building,

* Performance analysis,

* Positive thought control,

* Improving body language,

* Developing pre—performance preparation,
* Goal setting.

Aspects of sports performance such as being able to control anxiety and the ability
to stay focused at crucial times often dictate whether an individual is successful or
not. However, very little time is spent working on the mental game. Mental skills
need to be worked on just as physical skills are. Many sports performers are able

to perform to a high level in practice yet seem unable to ‘deliver the goods” when

they compete.

o
\ \

1

Keep it Simple
Stupid !!!
ol ) T
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Often the reason for this is that they have spent all their preparation time working
on their physical game and neglected their mental preparation. Therefore, when
they confront a pressure situation or they experience a loss of concentration they
do not have the relevant coping strategies to stay in control of their performance.
These individuals should be encouraged to spend time working on their mental
game, to allow them to fulfil their potential physically by preparing mentally.
Most individuals find that very simple mental strategies help them to feel more in
control of themselves and subsequently perform to a higher standard.

What are the Psychological benefits of the Quintic System?

The use of video analysis is important for a number of psychological reasons. ..

1. Visualisation.

Video analysis can help an individual to learn to visualise much more effectively.
By observing yourself performing consistently well on video you can enhance the
way that you see yourself perform in your mind. The use of video is particularly
useful for developing external visualisation (where you see yourself performing as
if on a television screen). This form of visualisation allows the individual to
observe themselves performing from afar. Therefore, they do not experience the
same thoughts, feelings and emotions that are felt when they visualise a situation
through their own eyes. This form of visualisation is particularly important when
building confidence and dealing with controlling anxiety.

2. Positive Reminders.

Most sports performers are encouraged to keep some kind of performance
analysis diary. A diary can be used to assess the strengths and weaknesses of recent
performances and can also be used as a positive reminder of good performances.
The Quintic system allows the individual to keep a library of positive
performances, which can be recalled simply at the touch of a button. Using the
memo pad feature you can also recall any important information regarding the
video clip that you are watching. For example a golfer can record a library of their
best shots with each club. The memo pad allows you to record any important
information regarding each swing, for example ‘swing keys’ or ‘swing thoughts’.
Thus, if they are beginning to struggle playing with a particular club the golfer can
recall an image of themselves playing at their best with that particular club. Using
the split screen function the player can then record their current swing and
compare it to their best swing. By using the synch function and running these two
images together the player can establish whether there are any technical
differences between the two swings. Any differences can be identified by the
coach and drills can be worked out to correct the fault.

"An example of the benefits of the Quintic system occurred when one particular
golfer lost his confidence in swinging one particular club. When using the split
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screen function the coach could not identify any technical differences between the
golfers current swing as compared to a good swing recorded three months
previously. It was clear that the golfer had simply lost confidence in their swing.
By seeing that there were no technical differences between the two swings the
golfer was reassured that their technique was not at fault. This put any 'technical
doubts' out of the golfers mind and ensured that he believed in his technical
ability. The memo pad feature also reminded the golfer of their ‘positive
thoughts’ and ‘swing keys’. In this case the player had stopped using one
particular swing key. The Quintic system had acted as a positive reminder for the

golfer and helped him rebuild his confidence in his swing".

3. Body Language.

Through the use of video analysis sports performers can become much more
aware of their ‘behaviour’. For example a tennis player might want to study their
body language after points that they have won or lost. Equally it is useful for
studying the body language of opponents. A coach can use the split screen facility
to show examples of both positive and negative body language as compared to that
of the player that they are working with.

4. Skill Development.

Because of the systems slow speed function, individuals can receive direct
feedback about a skill they are learning, immediately after performing the skill
itself. Therefore, throughout the learning process the player can see a visual
picture of what they are actually doing. This is very important, as often
individuals are not actually doing what they perceive themselves to be doing. By
using the systems spit screen function the coach can have a visual representation of
the skill being performed perfectly on one side of the screen and the current
image of the performer on the other. Thus the performer can see where the
adjustments need to be made to the technique in order to perform the skill
correctly. For more complicated skill development the lines / angles function can
be used to demonstrate the ‘fine tuning’ of technical development. Such a visual
representation can build confidence throughout the learning process.

Written by Dr Mark Bawden, Metaphorics Performance Consultants Ltd

o YA

App ying the spom&g metaphor
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Conversion Chart

Metres per Second > Miles Per Hour > Kilometres per Hour

Metres/s Mph Kph Metres/s Mph Kph
0.50 1.12 1.80 22.00 49.21 79.20
1.00 2.24 3.60 22.50 50.33 81.00
1.50 3.36 5.40 23.00 51.45 82.80
2.00 4.47 7.20 23.50 52.57 84.60
2.50 5.59 9.00 24.00 53.69 86.40
3.00 6.71 10.80 24.50 54.80 88.20
3.50 7.83 12.60 25.00 55.92 90.00
4.00 8.95 14.40 26.00 58.16 93.60
4.50 10.07 16.20 26.50 59.28 95.40
5.00 11.18 18.00 27.00 60.40 97.20
5.50 12.30 19.80 27.50 61.52 99.00
6.00 13.42 21.60 28.00 62.63 100.80
6.50 14.54 23.40 28.50 63.75 102.60
7.00 15.66 25.20 29.00 64.87 104.40
7.50 16.78 27.00 30.00 67.11 108.00
8.00 17.90 28.80 30.50 68.23 109.80
8.50 19.01 30.60 31.00 69.35 111.60
9.00 20.13 32.40 31.50 70.46 113.40
9.50 21.25 34.20 32.00 71.58 115.20
10.00 22.37 36.00 32.50 72.70 117.00
10.50 23.49 37.80 33.00 73.82 118.80
11.00 24.61 39.60 33.50 74.94 120.60
11.50 25.72 41.40 34.00 76.06 122.40
12.00 26.84 43.20 34.50 77.17 124.20
12.50 27.96 45.00 35.00 78.29 126.00
13.00 29.08 46.80 35.50 79.41 127.80
13.50 30.20 48.60 36.00 80.53 129.60
14.00 31.32 50.40 36.50 81.65 131.40
14.50 32.44 52.20 37.00 82.77 133.20
15.00 33.55 54.00 38.50 86.12 138.60
15.50 34.67 55.80 39.00 87.24 140.40
16.00 35.79 57.60 39.50 88.36 142.20
16.50 36.91 59.40 40.00 89.48 144.00
17.00 38.03 61.20 40.50 90.60 145.80
17.50 39.15 63.00 41.00 91.71 147.60
18.00 40.26 64.80 41.50 92.83 149.40
18.50 41.38 66.60 42.00 93.95 151.20
19.00 42.50 68.40 42.50 95.07 153.00
19.50 43.62 70.20 43.00 96.19 154.80
20.00 44.74 72.00 43.50 97.31 156.60
20.50 45.86 73.80 44.00 98.43 158.40
21.00 46.98 75.60 44.50 99.54 160.20
21.50 48.09 77.40 45.00 100.66 162.00
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Anatomical Movements

Movement: Elbow Extension

Start position: Elbow flexion
Finish position: Elbow extension

Movement: Suppination

Start position: Pronation
Finish position: Suppination

Movement: Forearm Pronation

Start position: Forearm Suppination
Finish position: Forearm Pronation
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Movement: Shoulder Adduction
Start position: shoulder Abduction
Finish position: Horizontal Abduction

Movement: Shoulder Abduction
Start position: Horizontal Abduction
Finish position: shoulder Abduction

Movement: Shoulder Extension

Start position: Neutral Shoulder position
Finish position: Shoulder Extension
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Movement: Shoulder Flexion

Start position: Neutral Shoulder
position
Finish position: Shoulder Flexion

Movement: Shoulder Adduction

Start position: Horizontal
Abduction
Finish position: Neutral Shoulder

position

Movement: Shoulder Abduction
Start position: Neutral Shoulder

position
Finish position: Horizontal
Shoulder Abduction.
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Movement: Outward Shoulder Rotation

Start position: Inward Shoulder rotation
Finish position: Outward Shoulder Rotation

Movement: Inward Shoulder rotation

Start position: Outward Shoulder Rotation
Finish position: Inward Shoulder rotation

Movement: Wrist Abduction
Start position: Neutral Wrist position

Finish position: Wrist Abduction
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Movement: Wrist Adduction
Start position: Neutral Wrist
position

Finish position: Wrist Adduction

Movement: Wrist Extension
Start position: Neutral Wrist
position

Finish position: Wrist Extension

Movement: Wrist Flexion
Start position: Neutral Wrist
position

Finish position: Wrist Flexion
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Movement: Ankle Plantar flexion
Start position: Neutral Ankle position
Finish position: Ankle Plantar flexion

Movement: Ankle Dorsi flexion
Start position: Neutral Ankle position
Finish position: Ankle Dorsi flexion

Movement: Ankle Inversion
Start position: Neutral Ankle position
Finish position: Ankle Inversion
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~ Movement: Ankle Eversion

 Start position: Neutral Ankle position
Finish position: Ankle Eversion

.. Movement: Hip Abduction
Start position: Neutral Hip position
Finish position: Hip Abduction

! 7]
~ Movement: Hip Adduction
Start position: Neutral Hip position

Finish position: Hip Adduction
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Movement: Hip Flexion
Start position: Neutral Hip position
Finish position: Hip Flexion

Movement: Hip Extension

Start position: Hip Flexion
Finish position: Neutral Hip position
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Movement: Knee
Flexion

Start position: Knee
Extension

Finish position: Knee
Flexion

Movement: Knee
Extension

Start position: Knee
Flexion

Finish position: Knee
Extension
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Digitisation Templates

Point 1

() Digitisation =S
Create Templates Help

Model 1 point
Default Colour [ uink width 2 &
Points 1 (& StepSize 1 &

1 Point1

A digitisation template showing a 1point digitisation model

7 Point 1

Q Digitisation
Create Templates Help

Model Leg|

Point 2
Default Colour Link Width 2

b | WH

Points 4 (& StepSize 1

9

i Hip

2 Knee .

3 Ankle Point 4

ot Toe .

Point 3

A digitisation template showing a 4 point digitisation model
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Q Digitisation
Create Templates Help

i

Model podiatry

DefauItCDInur.Link'u"a'idﬂ'u 2 !

]

Points 8 (& StepSize 1

wr

1 Left Hip

]

e

e
008

8 L@
D00
8 le

2 Left Knee
3 Left Ankle
= Left Toe

5 Right Hip

3 Right Knee
i Right Ankle

3 Right toe

Point 1 Point 5

Point 2
Point 6

Point 7

Point 3

Point 4

Point 8

A digitisation template showing an 8 point digitisation model
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Q Digitisation ==

Create Templates  Help

Model  Rowing]
Default Colour Link width 2 &
e e il [ T T T T T T T

@I

=IO
3 Glenohurneral e OOOOO
4 Hip OOO_OO
5 Elbow _OOOO
3 Wrist _OOO
7 Finger OOO
8 Knee _O

g Ankle

1 Vertex of Head

2 Tth Cervical

10 Toe

Point 1

Point 2

Point 6

Point 7

Point 4

Point 8

A digitisation template showing a 10 point digitisation model
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Q] Digitisation
Lreate Templates Help

Model 18 point model
Default Colour [ tink width 1
Points 18 {&] StepSize 1
vertex of the Head
7th Cervical vertebra
Left Glenohumeral |

Left Hip

1

2

3

4

5 Right Hip
[ Right Glenchumeral
7 Left Elbow

3 Left Wrist

9 Left 3rd Finger

10 Right Elbow

1l Right Wrist

12 Right 3rd Finger

13 LeftKnee
14 Left Ankle
15 Left Toe

16 Right Knee
17 Right Ankle

18 Right Toe

B @ W

S&O0)C))CICICy
(D[ | G 0 [ D | G | O [
=000

G D
(OO0
&)

& )

L0y

@)

=)

A digitisation ternpiate showing an 18 point digitisation model

Point 1

Point 2
Point 6

Point 3

Point
Point 7

Point 8

Point 9

Point 12 Point 4

Point 13

Point 16

Point 17

Point 14
Point 18

Point 15
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Q) Digitisation
Creste Templates  Help

Model 20 point model
Default Colour [ tink width 1
Points 20 ;% Step Size 1
1 Vertex of the Head
7th Cervical vertebra
Left Glenohumeral
Left Hip

Right Hip

2

3

5

5

6 Right Glenohumeral
7 Left Elbow

8 Left Wrist

9 Left 3rd Finger
Right Elbow
Right Wrist
Right 3rd Finger
Left Knee

Left Ankle

Left Toe

Right Knee
Right Ankle
Right Toe

Grip

Club Toe

W @8 ©0

| 1§

]

ele

e |

eLece

oohec e

 [emeen

| [Ieeeues
segneesuen |
aeseeusee |
laneeeeneen
SEEseens S0N
000000000000
800000000J0000e
SEEeeanane NaEe |
8000000000000000e
80000000000000000e
LD0C0DoO00LLOCOOL0e
0000000000000O0J0000

]

Point 5

Point 17

Point 18

Point 19

Point 1

Point 2
Point 3

Point 4
Pdint 8

Point, 9

Point 20

Point 13

Point 14

Point 16

A digitisation template showing a 20 point digitisation mode
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Centre of Mass Digitisation Model

The below diagram shows an example of an 18 point digitisation model which
takes into account all the major digitisation points on the human body. This is
used when creating a COM model. If you require Centre of Mass calculations,
please use the templates **18COM_MALE or **18COM_FEMALE which can be

found in C:\Quintic Sample Videos\Templates

1 Vertex of the Head

7™ Cervical Vertebra 2

N

Left Glenohumeral 3

/

Left Elbow 7

I

Left Wrist 8

|

COM 19

6 Right Glenohumeral

\

10 Right Elbow

\

11 Right Wrist

Left Hip 4

/

Left 3" Finger 9

Left Knee 13

Left Ankle 14

Left Toe (Big toe) 15

5 Right H()

12 Right 3™ Finger

16 Right Knee

17 Right Ankle

18 Right Toe (Big toe)
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ORIGIN

The origin of the graphs can be set as relative or absolute.

Relative uses the first digitisation point as the origin (0,0) and all measurements
are relative to this point.

Absolute uses the origin (0,0) bottom left hand corner of the screen.

CALIBRATION
All videos that are used in the Linear Analysis must be calibrated. This is a method

of relating pixel distances on the video with an actual scale —i.e. metres, feet.
Various options exist within the analysis screens for showing velocity as mps,

feet/sec, mph and kph.

SMOOTHING

It is recommended that filtering is used to smooth the raw digitisation data. See

Appendix K - Butterworth filters for more details.

DISTANCE

Distance can be illustrated as horizontal, vertical and/or linear measurements.
Horizontal is the horizontal distance from the origin (absolute or relative)
Vertical is the vertical distance above the origin (absolute or relative)

Linear is the actual distance of the digitisation point from the origin.

Note:- horizontal and vertical distances can be positive or negative but the linear
distance will always be positive.

SPLINES

Splines are methods of fitting continuous curves through a series of data points.
Quintic splines are then used to show the horizontal, vertical and linear distance
graphs. It is the spline fitting that allows interpretation of distances between
frames.

VELOCITY

The rate of change of distance gives velocity. If slight errors occur in distance
measurements then these can be amplified in the velocity calculations. So an
averaging method is used to help calculate velocities. The distance before each
point and the distance after each point are used to get an average velocity.

ACCLERATION

The rate of Change of Velocity gives acceleration. Similar averaging methods are

used to get average accelerations.

Angular Analysis
The picture below shows the results for angle B2>C3>D4
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The angle of the ankle varies from approx 87° to a max of 120° degrees.

Angular Displacement (deg) for [ Knee =B = C]

100 200 300 400 500 600 700
Frame humber

IMPORTANT — All angles are measured using the standard anti-
clockwise convention. I.e. the angle from B2 to C3 to D4 (in the

anticlockwise direction). The angle of the ankle is in the range 87°-120°.

Now look at the angle A1l to B2 to C3. This is a reflex angle and is in the range
255°-310°. The reflex angle is now shown by default.

Angular Displacement (deg) for [Hip=B=C]

305 T L I 1 R & Ty | BIEEEE! | EEFEER | EERERST L B
a0 f1----{-1--

295 - :

ERY RO B L

=t [ WA NN, RN NN (NN (NN SRR O ISR JPU RN RPN U R (R N

270 §--L-- - : . ; :
265 §--1-d----- - {ro-- A e -
260f--44-----% ]
255 :

t t t t t f t
100 200 300 400 500 600 700
Frame humkber

To display the acute angle within the graphical analysis, select display from the
menu and unselect Reflex Angles

Angular Displacement (deg) for [Hip=B=C]

LR e i - S 7
LI R e al LRnty & | EEEEE S BEEFTE A SEEER S 3 EEREEE! S SEERP Y FERES L
(e L e ¥ e
s Y

1 UIU 2EIIEI SUIU 4UIU SUIU BUIU ?UIU

Frame Mumber
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Butterworth Filters

It is important to smooth data, which has been produced by Quintic manual
digitisation or automatic tracking. Markers are usually attached to a subject to
make the digitisation process easier and more accurate, from these markers the
digitisation of the subject can occur. Errors in the digitisation process are possible,
for example, actual errors while digitising (when locating the marker using
manual mode) or due to skin and muscle movement over a joint centre. It is

important to smooth the data to try and eliminate these errors.

A common method of smoothing data is to use Butterworth filters.

These filters tend to reduce the ‘noise’ in any signal and hence are better at
obtaining the true underlying trend in any data series. The typical time series data
signals from any (human) movement tend to occur at low frequencies while any
errors are more likely to be at much higher frequencies. Low Pass Butterworth
filers reduce the ‘noise’ from high frequency signals but keep the low frequency
signals.

There are many other digital filtering methods such as Fourier smoothing
although Butterworth filters are robust and tend to give good results when applied
to data series for human movement.

Quintic uses a method that looks for the optimal smoothing of any data series by
comparing the difference between the raw data and smoothed data while still
retaining a smooth data series as output
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Quintic Data Smoothing Screens

|Q| Quintic Data Series... Pointl X - Horizontal Data Series - &

Raw Data v Smoothed Data Spectral Density Function

— oo : : : : : |
— Smuutnedl 0.013 B f f f f | [ Smeothed

0.012
0.011

0.01 §---
0.009 4---
0.008 &---
0.007 §---
0.006 §---

0 ettt
0 10 20 30 40 S0 B0

t t t t t t t t t t u t t
0 100 200 300 400 SO0 600 VOO @00 900 1,000 1,100 1,200 1,300

Residuals at Cutoff Frequency Interactive Frequency Analysis

.
_ ] =] +| 16.80 | (B Best Filters

Residual Analysis

Observations 1377
Recording Speed (fps) 100.00
Mean -0.0003
Standard Deviation 0.0910
Durbin Watson 1.987

Data Series Name:-
Point1
X -Horizontal Data Series

u t t t t t t t t t t t t t
0 100 200 300 400 500 &S00 70O 800 900 1,000 1,100 1,200 1,300

“Raw Data v Smoothed Data”

This graph displays the smoothed and raw series. If they look similar then the
optimal smoothing method would appear to give sensible results.

“Residuals at Cut-Off Frequency”

This graph shows the difference between the smoothed and raw data. Looking at
this graph is important because if the residuals are small and randomly spread
about zero then this indicates that the smoothing method is not biased and is not
removing any “spiked values” from the raw data series. It could be that these spike

values are important in any analysis.
“Spectral Density Function”

This graph shows the different frequencies that make up the digital signal of the
“Cycling Video”. Most of the frequencies are low i.e. less than 5 Hz.
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Interactive Frequency Analysis

The program has calculated the optimum filter for this series. I.e. 16.8

(If the residuals have a mean which is close to zero and a low standard deviation
then this indicates a good cut-off frequency. As a further test if there is no bias in
the residuals then the auto-correlation between successive values should also be
close to zero. The Durbin Watson (DW) statistic is used to assess the auto-
correlation. If the DW statistic is close to 2.00 then this indicates no significant
auto-correlation.

It is possible to interactively change the cut-off frequency by moving the scrollbar.

i.e. if the scrollbar is moved to the left (say 4.0) then this cut-off frequency still
gives a low mead and standard deviation. However the DW statistic is close to
zero, which indicates an auto-correlation in the residuals. I.e. this is not a good
cut-off frequency for this data series. There is also a visible difference between the
raw and smoothed data also indicating a cut-off frequency of 4.0 is poor result.

Try moving the scrollbar to the right. I.e. increasing the cut-off frequency. If the
cut-off frequency approaches 30.0 then the smoothing becomes unstable and these
smoothing frequencies should not be used. It is well known that Butterworth cut-
off frequencies can become unstable. So it is always important to “eye-ball” each
series to make sure you are using sensible smoothing parameters. The optimum
cut-off frequency produced by the program should give a good starting point for
checking each series.
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De-register Quintic Licence

Through Quintic Security each licence is dedicated to recognise one computer.
Any change in or of that computer means the software will not recognise it and
therefore not function. To allow for changes Quintic Security allows you to
uninstall the software twice in any 12 months and reinstall it on the changed
computer. NB — Change means a change of components within a computer or a
change to a different computer.

There is an automated system for which the computer must be connected to the

Internet to use.

To uninstall Quintic software off your computer please follow these step by step
instruction, ensure you are connected to the Internet.

1. Select the help tab off the main menu bar and left click on the help button as

illustrated below.

Q)] Quintic Biomechanics v21 o] = |z

| Main | Markers I Shapes I Angles I Report | Digitisation I System I Camera | Blend | Help |

[ Quintic Biomechanics v21 Copyright © 1997-2012 ] [ ? Help ]

2. Highlight ‘De-register Quintic Licence’ and right click to start the unistallation

process.

Q)] Quintic Biomechanics v21 [ = |3

| Main I Markers | Shapes I Angles I Report I Digitisation | System I Camera I Blend | Help |

( Quintic Biomechanics v21 Copyright ® 19972012 | E% Hep ]

Quintic Software Tuterials v21
Quintic Quick User Guide (*.pdf)
About Quintic

De-Register Quintic Licence
www.quintic.com
www.quinticsoftware.com

Save Window Locations

5 3

3. A warning box will now be loaded asking you to confirm the continuation of
the de—registering process. Right click on the yes button to continue the

pI‘OCGSS .

Warning ==

l . This function will de-register your Quintic Licence and
your software will no lenger operate on this computer,
Do you want to continue with de-registering?

..............
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4. The computer will now generate your original security Code A in the 5
boxes at the top of the generated window. Read the warning box located in
the window after you have read this you have another opportunity to cancel

the uninstall process.

5. Click “Yes’ and the next pop up window that is generated is your final
chance to cancel the de-registration process, if you wish to continue right
click on the ‘Yes’ button if you wish to cancel the process click on the ‘No’

button.

Q De-Register Your: Quintic Biomechanics v21

Quintic Software Security ® “Zys"

Your Security Code A for this Quintic Software is:

You are permitted to operate this Quintic Software
on OMNE computer at any one time and have two
De-Registrations per annum. Proceeding with this

De-Registration will disable this Quintic Licence from
this computer. In order to use this Licence on
another computer you will need to submit the

Code D to the Quintic website. This will reset
Security Code A.

Do you wish to proceed with De-Registering ?

Yes x Cancel De-Registering
Quintic Software Security © Copyright 2003 All Rights Reserved

X3

Confirm @

.: | Final chance! Do you still want to De-Register this
Quintic Licence?

Information @

i | Mote:- For your reference Quintic has written a small
& text file to the desktop called 'Quintic Licence'
This file contains your & and D codes
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Ensure that you are connected to the Internet
for this next stage...

6. Your Quintic software has now been disabled from your computer and will
not run. Uninstall security code D has been generated. The generated D code
must now be submitted to the Quintic website so that your original A code
can be reset so that you may install the software on another computer. This is
achieved by right clicking on the ‘Code D’ button or by accessing the
website: www.quintic.com/software_security

Q De-Register Your: Quintic Biomechanics v21 (3w

Quintic Software Security © 5

Your Security Code A for this Quintic Software is:

-. zaacs  Javest  fuzmsm Jvarew

Your Security Code D is given below:
DEWSE Q5EMF 3CT035 RAIFS S5LEQ

Your Quintic Licence has now been disabled from
this computer and will not run. Please now go to the
Quintic website to reset your Security Code A so that
you may register the Licence on another computer.
Please click on the button below or go to the website
‘wawawguintic.com/software  security’

Quintic Software Security ® Copyright 2003 All Rights Reserved

7. The next window you see will ask you to type in you’re Security Code A and
Uninstall Code D or to check that they are correct. After this has been done
right click on the ‘Submit’ button.
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http://www.quintic.com/software_security/

Quintic Security
Uninstalling Code D

Your Quintic v21 is licensed to
OME Person:

£ any ONE time.

You must click the SUBMIT button below to complete your
uninstallation or your software will be invalidated

Please Type in your Quintic Security Code A and
Uninstall Code D or check that they are correct.

Security Code A: QHJBN - ZASC3  3WGST LZMBM  V3IYYW

Uninstal Code D: DKWSE OSEMF  BC7D5 RAIFS  SSLEQ

SUBMIT

sultancy Lid: Copyright ©1996 - 2012 All Rights Reserved

#1 fon orts Analysis

After submitting you're Security Code A and Uninstall Code D to the website
you should receive an email to your registered email account confirming that
your Security Code A has been reset if you have received this email right click
on the ‘Yes’ button. If you have not received this email after a couple of

minutes right click on the ‘No: Go to Quintic website button’ and follow the
instructions.

Q Confirm Uninstallation of: Quintic Biomechanics v21 £3

Quintic Software Security © ="

2003

Your Security Code A for this Quintic Software is:

Your Uninstall Security Code D is given below:

You are in the process of De-Registering this Cluintic
Licence from this computer. Have you had
confirmation (from the Quintic Website) that your
Security Code A has been reset?

@ Mo Goto the Quintic website
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The uninstall process has now been completed and your Security Code A has
been reset. You may now install the Quintic software onto another
computer. We suggest that you go to START/SETTINGS/ CONTROL
PANEL/ADD-REMOVE PROGRAMS to delete the Quintic software from
the original computer.

Quintic Biomechanics v21

Quintic Uninstall Code D has been successfully entered.

Security Code A can now be used on a new computer.

Information @

| Your Security Code & has now been reset. You may now
¥ install this

Quintic Software on another computer, We suggest that
you go to

START/SETTINGS/CONTROL PAMNEL/ADD-REMOVE
PROGRAMS

to delete this Quintic Software from this computer,
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